# Table of Contents

## Introduction
- System Requirements ................................................................. 1
- Installation ..................................................................................... 1
- How to Get Help ........................................................................... 1

## Connecting
- Connection Wizard ........................................................................ 2
  - Welcome .................................................................................... 3
  - ARC-16 Settings (via direct connection with null modem cable) ........ 4
  - ARC-16 Settings (via parent site) ............................................... 5
  - Connection Settings ................................................................... 6
  - Finish ....................................................................................... 7
- Connect using Saved Settings ....................................................... 8
- Connect using Recent Settings ..................................................... 9

## Downloading ................................................................................. 10
- Uploading .................................................................................... 10
- Local Options ............................................................................. 11

## Communication Settings ............................................................... 13
- Channel Settings ......................................................................... 15

## ESI Settings .................................................................................. 17
- ESI Labels ................................................................................... 18

## Saving and Opening Files ............................................................... 19
- Opening ....................................................................................... 19
- Saving ......................................................................................... 19
Introduction

AutoLoad 2 gives you access to your ARC-16 configuration settings from the comfort of your computer. Use AutoLoad to back up your configuration to disk, so that you can easily restore your settings in the future if you ever clear your unit’s configuration. AutoLoad also makes it easy to enter channel labels and ESI vocabulary, making ARC-16 setup a breeze. And if you ever need to replace your ARC-16 with a backup unit, you can use AutoLoad to restore your old settings to the new unit.

System Requirements

- ARC-16 firmware version 5.4 or above
- Enhanced Speech Interface (ESI) or Computer Interface (CI) installed in ARC-16
- Pentium 133MHz or better
- 32 MB RAM
- Windows 98, ME, NT 4.0 SP5, 2000 SP1, XP
- Bell 212A compatible modem (if using a modem connection)

*Note: The Support section of the Burk Technology web site provides a list of several compatible modems with installation notes and initialization strings where needed. Additional modems may work; you should verify Bell 212A compatibility with the modem manufacturer.*

**IMPORTANT!** If you are using ARC-16 firmware version 5.4 or 5.5, AutoLoad 2.0 or AutoLoad 2.1 may be used for PC-based configuration of your ARC-16. If you are using firmware version 5.6, please use AutoLoad 2.1. You can verify your version of AutoLoad by selecting About… from the Help menu.

Installation

To install AutoLoad, insert the CD-ROM into your CD drive. If the CD does not start automatically, click Start, then select Run. Enter d:\launch.exe (where “d” is the letter of your CD-ROM drive). Click “Install AutoLoad” to begin the installation.

To launch AutoLoad, click on the AutoLoad icon in the start menu, under Burk Technology\AutoLoad. When the opening screen appears, select whether you want to download settings from an ARC-16, or upload settings that you previously saved using AutoLoad.

How to Get Help

The help file can be accessed from AutoLoad by clicking on the help menu.

“What's This” help is also available to provide quick descriptions of AutoLoad's features.
Connecting
Before you can download from or upload to your ARC-16, you need to define a connection. The first time you do this, you will use the Connection Wizard. Once you have at least one connection, you can connect using a saved connection, or just use the most recently used settings.

Connection Wizard
When you download or upload, if you have not previously established a connection, the Connection Wizard will load automatically. Otherwise, the Connection Settings dialog will be shown (below). To launch the Connection Wizard from the dialog, select "Create a new connection" and click OK.
Welcome

The first page of the Connection Wizard asks you to determine if your ARC-16 is connected directly to the computer, or via another unit. Here are some examples:

If you want to download settings from Site A. Select the first option if:

- Your computer is physically connected to Site A with a serial cable, or;
- Site A has an ESI that you can call using your computer's modem.
Select the second option if:

- Your computer is physically connected to Site B, C, or D. This "parent" site is connected to Site A or;
- Site B, C, or D has an ESI that you can call using your computer's modem. This "parent" site is connected to Site A.

Note: You cannot use AutoLoad to complete first-time configuration of port settings in remote units. In order for AutoLoad to connect to one unit via another, the site letter and send/receive settings must be set up for both units using the front panel controls.

ARC-16 Settings (via direct connection with null modem cable)

Serial Number
Enter the serial number of your ARC-16 you are directly connected to. The serial number is a 6-digit number, and can be found on the back of the unit. If the serial number on the back of the unit is a five-digit number, add a leading 0 to serial number when you enter it in AutoLoad.
Site Letter
Enter the site letter (A, B, C, or D) of your ARC-16.

Password
Enter the USER password for the ARC-16. The MASTER password will not work.

ARC-16 Settings (via parent site)

Serial Number
Enter the serial number of the ARC-16 that your computer is directly connected to. The serial number is a 6-digit number, and can be found on the back of the unit.

Site Letter
Enter the site letter of the ARC-16 that your computer is directly connected to (A, B, C, or D).

Password
Enter the USER password for the ARC-16 that your computer is directly connected to.

Destination Site Letter
Enter the site letter (A, B, C, or D) of the ARC-16 that you are downloading from or uploading to. This should be different from the "parent" site letter.
Connection Settings

Direct Connection (not shown)
Select the COM Port from the drop down list.

Modem Connection
Select the modem from the drop down list, and enter the phone number.
Finish

Check "Save my connection settings for future use" to save these settings to a file.

Check "Save password" if you want your password saved along with the other settings. If you are not the only user of your computer, you may not want to do this for security purposes.

Click Connect to start downloading/uploading. When the download is complete, your ARC-16 settings will be displayed in the configuration window.
Connect using Saved Settings

To load a previously saved connection, select the option: "Load a saved connection". The drop down list will contain all the saved connections found in AutoLoad's default connection folder. If you saved your settings in a different folder, click the "browse" button (...) to find the connection file. The serial number, site letter, COM port/modem, phone number, and password will be loaded.

**Note**: the password is only loaded if you chose to save it from the Connection Wizard. If you did not, then you will have to enter the USER password before connecting.

You will need to select the site letter of the ARC-16 that you want to download from.

**Note**: when uploading, you can not select the destination site letter. You can only upload to the site letter from which you downloaded your settings. This is to prevent misconfiguration of the ARC-16.

**Note**: if you are connecting directly to the ARC-16, the "download from site" letter will be the same as the site letter you entered above. However, if your ARC-16 is connected via another unit, these site letters will differ.
Connect using Recent Settings

Select the option: "Use the most recent settings". The serial number, site letter, COM port/modem, and phone number that you last used to connect will be loaded. You will need to enter the USER password, and select the site letter of the ARC-16 that you want to download from or upload to.

Note: when uploading, you can not select the destination site letter. You can only upload to the site letter from which you downloaded your settings. This is to prevent misconfiguration of the ARC-16.

Note: if you are connecting directly to the ARC-16, the "download from site" letter will be the same as the site letter above. However, if your ARC-16 is connected via another unit, these site letters will differ.
**Downloading**

To download settings from your ARC-16, click "Download..." from the ARC-16 menu, or click the Download button from the AutoLoad startup screen (below).

You will be prompted for connection settings. When the download is complete, your ARC-16 settings will be displayed in the configuration window.

**Uploading**

To upload settings to your ARC-16, you must first load configuration settings either by downloading or by opening a saved file. To start the upload, click "Upload..." from the ARC-16 menu. You will be prompted for connection settings.

**Note:** the upload process may take several minutes.

**Restoring Calibration Settings**

If you want to restore your ARC-16 calibration settings, check the box labeled "Restore calibration settings" from the Select AutoLoad Connection dialog.

**IMPORTANT!** If you have changed your calibration settings since the last time you downloaded your site configuration, and you want keep those changes, do not check the “Restore calibration settings” box.
Configuration
To edit your ARC-16 configuration, open a saved file or download settings from your ARC (these options are on the main screen when you launch AutoLoad). Your settings will be displayed in the configuration window (seen below). The settings are divided into five categories:

- Local Options
- Communication
- Channel Settings
- ESI Settings
- ESI Labels

Local Options

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Label</td>
<td>The site label for the local unit, up to 8 characters.</td>
</tr>
<tr>
<td>Channels 1-8</td>
<td>Check this box if the local unit has an I/O card for channels 1-8.</td>
</tr>
<tr>
<td>Channels 9-16</td>
<td>Check this box if the local unit has an I/O card for channels 9-16.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Local ESI</td>
<td>Check this box if the local unit has an ESI (Enhanced Speech Interface).</td>
</tr>
<tr>
<td>Use DTMF</td>
<td>Check this box to enable DTMF (only applicable if the unit has an ESI).</td>
</tr>
<tr>
<td>Two Ports</td>
<td>In <strong>firmware version 5.4</strong>, check this box if the local unit has a TPA (Two Port Adapter). In <strong>firmware version 5.5</strong>, both modem ports are enabled by default; check this box even if only one modem is installed. In <strong>firmware version 5.6</strong>, this menu option does not appear.</td>
</tr>
<tr>
<td>Site (X) ESI</td>
<td>Check this box if the site listed (X) has an ESI.</td>
</tr>
<tr>
<td>Site (X) SSI</td>
<td>Check this box if the site listed (X) has an SSI.</td>
</tr>
<tr>
<td>Enable Limits Monitoring</td>
<td>Check this box to enable limits monitoring on the local unit.</td>
</tr>
</tbody>
</table>

**Change Passwords**

If you want to change the password(s), check the "Change Password" box. Enter the existing MASTER password. Enter and confirm passwords for MASTER and USER.

**Note:** if you do not want to change one of these passwords, you can enter the old existing password instead of a new one.

To make the change, you need to upload your settings.
# Communication Settings

![AutoLoad 2 Interface](image)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Received From</td>
<td>The port that the local unit uses to receive data from Site (X).</td>
</tr>
<tr>
<td>Data Sent Out</td>
<td>The port that the local unit uses to send data from Site (X) to other sites. In firmware version 5.6, data is sent on both ports by default, and this setting does not appear.</td>
</tr>
<tr>
<td>Highest Channel</td>
<td>You may assign a Highest Channel at each site so that only in-use channels are displayed on the front panel, and so that sites with no channels are not displayed at all.</td>
</tr>
</tbody>
</table>

**Note:** The Data Received/Sent settings are disabled for the local site to prevent a configuration error.

### Baud Rates

In firmware versions 5.4, check the box under Baud Rates if your ARC-16 has been modified to operate at 1200 baud. You can set the baud rate for Ports 1 and 2 to either 300 or 1200.
Note: This modification is not made to most ARC-16s. If you are unsure if your ARC-16 has been modified, then it probably has not. An unmodified ARC-16 operates at 300 baud.

With firmware version 5.5, no modification is necessary to enable 1200 baud, but you should still check the box under Baud Rates to enable the 1200 baud option.

If you are using firmware version 5.6, baud rates up to 9600 bps are available with bi-directional digital links. If you are using a digital link, set the desired baud rate for the appropriate port. Subcarrier, audio and wire links must operate at 300 baud.
## Channel Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>The channel label can be up to 7 characters. <em>Even though the text box allows more characters, channel labels greater than 7 characters will not be saved to the unit.</em></td>
</tr>
<tr>
<td>Status Alarm</td>
<td>Check this box if you want status alarms reported on this channel.</td>
</tr>
<tr>
<td>Invert Status</td>
<td>Check this box to invert the polarity of the status.</td>
</tr>
<tr>
<td>Decimal Point</td>
<td>Select the location of the decimal point.</td>
</tr>
<tr>
<td>Low Limit</td>
<td>Enter the low limit for this channel. The limit will use the decimal point setting for the channel.</td>
</tr>
<tr>
<td>High Limit</td>
<td>Enter the high limit for this channel. The limit will use the decimal point setting for the channel.</td>
</tr>
<tr>
<td>Raise Duration</td>
<td>Enter the duration of the Raise command. The duration can range from .2 to 28 seconds, and can be entered using 1/10 second. A value of 0 can be used for the default duration or .7 second. <em>Note:</em> the command duration is not fully accurate to 1/10 second; some rounding may occur.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Lower Duration</td>
<td>Enter the duration of the Lower command. The duration can range from .2 to 28 seconds, and can be entered using 1/10 second. A value of 0 can be used for the default duration or .7 second. <strong>Note:</strong> the command duration is not fully accurate to 1/10 second; some rounding may occur.</td>
</tr>
<tr>
<td>High/Low Alarm Delay</td>
<td>Enter an alarm delay for high/low (limit) alarms. The delay can be between 1 and 126 seconds. Enter 0 for no delay.</td>
</tr>
<tr>
<td>Status Alarm Delay</td>
<td>Enter an alarm delay for status alarms. The delay can be between 1 and 126 seconds. Enter 0 for no delay.</td>
</tr>
<tr>
<td>Convert Type</td>
<td>Choose the conversion type (for calibration). The options are Degree, Linear, Power, and Indirect. See the ARC-16 manual for more information.</td>
</tr>
</tbody>
</table>

---

Customer Support: 978-486-3711 • support@burk.com • www.burk.com
**ESI Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dial out on alarm</td>
<td>Check this box if you want the ESI to dial out (using the phone number list) when an alarm occurs.</td>
</tr>
<tr>
<td>Answer incoming calls</td>
<td>Check this box if you want the ESI to answer incoming calls (calls can be voice or data).</td>
</tr>
<tr>
<td>Answer after X rings</td>
<td>Enter the number of rings that the ESI should wait for before answering a call (only applies if the “answer” option is enabled).</td>
</tr>
<tr>
<td>Phone numbers</td>
<td>Enter up to 9 phone numbers that the ESI should try to dial in the event of an alarm. The numbers will be dialed in order. See the ARC-16 manual for more information.</td>
</tr>
</tbody>
</table>

**Sign-On Message**

The sign-on message is played when the ESI answers an incoming call. To enter the message, select up to 16 words using the drop down lists in the table (the order is left to right, then top to bottom). **Note:** the word "hello" is automatically spoken before the sign-on message.
**Tip:** to enter words quickly, start typing the word you want. The drop down list will fill in the rest of the word once it finds a match. To remove a word, choose the blank entry from the bottom of the list.

**ESI Labels**

ESI labels fall into four categories: Site, Channel, Units, and Status. See the ARC-16 manual for more information.

To enter labels, first select the site letter from the navigation bar on the left. Then select the icon for the type of label you want to edit. The icon will change to the "edit" icon (as seen above), and the grid caption will show the site and label type.

Use the drop down list to enter each word of the label.

**Tip:** to enter words quickly, start typing the word you want. The drop down list will fill in the rest of the word once it finds a match. To remove a word, choose the blank entry from the bottom of the list.
Saving and Opening Files

Opening
To open a file, click "Open" from the File menu in the configuration window, or click the Open button from the AutoLoad startup dialog (seen below). Select the file that you want to open. The ARC-16 settings will be displayed in the configuration window.

Saving
To save changes to your configuration, click "Save" from the File menu.

Note: the configuration file is specific to the site letter from which it was downloaded. However, it is not serial number specific. This means if you downloaded these settings from Site A, you can only upload back to a Site A. If you need to replace an ARC-16 with a backup unit, configure the backup to be the same site letter as the old unit; then use AutoLoad to restore your original settings.